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1.0 INTRODUCTION 

1.1 Background  

The first version of the Placer County travel demand model was developed for use in Placer County’s 
1992 Congestion Management Program. It was pieced together from earlier models for individual cities 
and from SACOG’s regional model. This model was superseded in 1996 by a new model developed for 
use in updating the County’s General Plan and for preparing nexus studies for impact fees in 
unincorporated parts of Placer County. The model was developed in MINUTP, a software package that 
was widely used at the time but has since been replaced by other, more powerful software packages. 
Trips to and from the other five counties in the SACOG region were based on SACOG’s regional model 
SACMET. 

The next model was developed in the early 2000’s. It was sponsored by the Placer County 
Transportation Commission, now known as the Placer County Transportation Planning Agency (PCTPA), 
for use in the initial nexus study for the South Placer Regional Transportation Agency (SPRTA) impact fee 
program in 2002. There is limited documentation for this model, but it is clear that it switched software 
platforms from MINUTP to CUBE, and focused on the southwest portion of the county. The model was 
updated in 2007, 2009, and 2014 for use in of updates of the SPRTA fees. 

In addition to the SPRTA model, there are other models currently in use that cover all or part of the 
SPRTA region. These include SACOG’s SACSIM model, the replacement for SACMET, and local models 
maintained for the cities of Roseville, Rocklin, and Lincoln. 

In 2020 PCTPA engaged WSP to update the SPRTA model for use in a nexus update of the SPRTA fee 
program. The updated model is intended for use in PCTPA’s planning work and by member agencies in 
their traffic studies. In the interests of continuity, many features of previous models have been carried 
over into the new model; for example the CUBE software platform and the land use categories. 
However, new features have been added to keep abreast of modeling needs. For example, a component 
has been added to forecast VMT pursuant to a new requirement under SB-743. 

1.2 Purpose of this Report 

The purpose of this guide is to provide information that new users of the SPRTA model may find useful. 
The guide discusses the contents of the files that comprise the model and describes how to perform the 
most common modeling tasks. 

A companion document, the SPRTA 2021 Model Development Report. It describes the structure, input 
data, model assumptions, and validation results of the updated PCTPA Model. This report can then be 
cited in the documentation of studies that make use of the model as evidence that the model used met 
or exceeded industry standards for accuracy. 
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2.0 DISPLAY DATA 

2.1 Displaying Network Data 

2.1.1 Labeling Daily Loaded Volumes 

The model output files, including loaded network files, are stored in each model year’s outputs folder. 
The 2019 daily loaded volumes can be displayed as follow: 

1) Open the 2019/outputs/LOADED_2019_DAILY.NET file using Cube. 

2) Click the Post All icon under Post Link group (Home → 
Post Link → Post All) 

 

 

 

3) In the Posting Selection, click the pull-down button (pointed below) and select VOL_DAY, 
which contains directional daily volumes. 

 

 

 

 

4) Click OK to display directional 
daily loaded volumes. 
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2.1.2 Labeling Node/TAZ numbers 

The Node/TAZ numbers can be displayed as follow: 

1) Open any network file such as 2019/outputs/LOADED_2019_DAILY.NET using Cube. 

2) Click the Post All icon under Post 
Node group (Home → Post Node → 
Post All) 

 

 

3) In the Posting Selection, the attribute N should be already selected. If not, click the pull-
down button (pointed below) and select N (from node attributes), which contains node 
numbers. 

 

4) To display node numbers, skip 
this step and go to Step 5. To 
display the only nodes 
representing TAZ numbers, add 
criteria, _CENTROID = 1, as 
shown: 

 

5) Click OK to display node or TAZ 
numbers. 
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2.1.3 Displaying a Link Attribute Using Color 

Colors can be utilized to display network attributes. The following steps demonstrate how to display the 
number of lanes in the 2019 working network. 

1) Open the 2019/outputs/Roads_2019.NET using Cube. 

2) Click the Color icon under Post Link group (Home → Post 
Link → Color)  

 

 

3) In the color setting, click the Append or Insert button to add another row. 

 

 

 

 

 

4) The color/thickness/line type of links can be defined in the color setting as shown below: 

 

 

 

 

 

 

5) Click Close to apply the 
color setting. 
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2.1.4 Hide Unnecessary Links in Master Network 

Users may start with each year’s model network or master network as a starting point of editing model 
network. The following procedure demonstrates how to display the only links actively used by the 2019 
model: 

1) Open the _MasterNet/Roads_Master_vXX.NET file using Cube. 

2) Click the Color icon under Post Link group (Home → Post 
Link → Color)  

 

 

3) In the color setting, click the Append or Insert button to add another row. 

 

 

 

 

 

4) Type FLG19 = 0 in the Criteria section and type 0 (zero) in Size. 

 

 

 

 

5) Click Close to apply the color setting. 
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2.2 Create Bandwidth Map with V/C Ratio 

The following steps demonstrate how to display PM 1-hour volumes by link thickness and V/C ratio by 
color. 

1) Open the 2019/outputs/LOADED_2019_PM1.NET file using Cube. 

2) First, create a bandwidth map by clicking the Multi-Bandwidth icon under Analysis ribbon 
tab (Analysis → Multi-Bandwidth) 

 

 

 

 

3) In the bandwidth setting, select a volume attribute, such as V_1, which contains the 
directional PM 1-hour volumes. 

 

 

 

 

 

 

4) If users desire to hide 
centroid connectors, 
type CAPCLASS <> 63 in 
Selection Criteria. 

 

 

 

 

 

 

5) Click OK to apply the bandwidth map. 

6) To apply the V/C ratio by color, click the Color icon under 
Post Link group (Home → Post Link → Color). 
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7) Colors could be defined for each V/C ratio range as follow. Additional rows can be added by 
clicking the Append 
or Insert menu. 

 

 

 

 

 

8) Click Close to apply the color setting. The bandwidth map with V/C ratio will be displayed as 
follow: 
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2.3 Displaying TAZ Data with a Boundary Layer 

1) To display TAZ 
boundary as 
another layer, click Layer Control icon in the 
Network Toolbar:  

2) Click the check box next to Boundary. 

 

 

 

 

 

 

3) In the Boundary Layer Parameters, click the 
Browse button. 

 

 

 

 

 

 

 

 

 

4) Select a TAZ boundary shape file 
and click Open. 

 

5) Then, it will go back to the 
Boundary Layer Parameter 
window. Click All Done to apply 
the boundary setting. 
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3.0 EDITING NETWORK FILE 

3.1 Editing the Attributes of a Single Link 

1) Open either the scenario network file (2019/outputs/Roads_2019.NET) or the master 
network file (_MasterNet/Roads_Master_vXX.NET) using Cube, depending on which 
network is a starting point of a new project. 

2) Click the arrow icon in the Network Toolbar and click a link in the network for edit. 

 

3) In Highway Links, you can overwrite attributes for the 
selected link. 

 

 

4)  Once the edit is complete, click the Save Current Item 
button. 

 

 

 

 

 

 

 

 

5) Click Save in File menu to save the changes to the network file. 
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3.2 Editing the Attributes of Multiple Links 

Cube has a function to fill in multiple records; however, limited options are available to select/define 
links. Options include: 

• Define by condition/formula using values of attributes 

• Select by polygon 

Users can use one of these options or a combination of both. 

1) Depending on which network is a starting point of a new project, open either the scenario 
network file (2019/outputs/Roads_2019.NET) or the master network file 
(_MasterNet/Roads_Master_vXX.NET) using Cube. 

2) Click New under Drawing Layer 
(Drawing Layer → Edit Polygon 
→ New) 

 

3) Draw a polygon to include targeted 
links. 

 

 

4) Click the Compute under the Link ribbon tab (Link → 
Link Data → Compute). 

 

 

5) In Link Attribute Calculation, click the right-
mouse button in the formula area and click 
Append or Insert. 
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6) In Equation, add a formula to fill an attribute with value, such as LANES = 3 and click OK. 

 

 

 

 

 

7) In Link Attribute Calculation, pick All items inside 
polygon NOW to apply to links within the polygon 
defined earlier. 

8) Other conditions could be further applied in the 
Condition if necessary. 

 

 

 

 

 

 

 

9) Click Apply to complete the computation. 

10) Click Save in File menu to save the changes to the network file. 

3.3 Adding a Link 

1) Open a network file. 

2) Click the arrow icon in the Network Toolbar. 

 

 

3) Click a link that has a similar set of attributes that is 
desired for a new link. 

 

 

 
4) Ctrl+C and then Ctrl+V. Then the arrow shape mouse will turn into the + shape.  
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5) Draw a new link connecting the start and endpoint.  

 

 

 

 

6) Click Save in File menu to save the changes to the network file. 
 
 

3.4 Deleting a Link 

Deleting a link in Cube is straightforward. Select a link with the arrow icon in the Network Toolbar. Press 
the Delete button on the keyboard and save the file. 
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4.0 RUNNING THE MODEL 

4.1 Cube Voyager 6.4.4 

SPRTA Model was developed using Cube/Voyager 6.4.4 software. Users will need to purchase the 
Cube/Voyager license from Bentley Systems, Incorporated (www.bentley.com). It should be noted that 
using a different version of Cube/Voyager program may result in a different result or may not work. 

4.2 Running a model 

SPRTA Model is designed with two steps: a pre-step that generates a scenario network file from the 
master network file and a regular model step. Users may choose to run either only the regular model 
step or both steps.  

4.2.1 Run without Master Network 

If a user doesn’t need to edit the model network or need to edit a network simply, the only folder 
needed is a scenario year folder. Here are steps to run a 2019 model: 

1) Copy the 2019 folder to any folder on your computer. 

2) Edit any input files if necessary. A scenario network is stored in the “output” folder. All other 
input files are stored in the “inputs” folder. 

3) Run the SPRTA regular model script (SPRTA_Script_2019_vXX.s) with Voyager 6.4.4 by double-
clicking it. The SPRTA Model does not require a prefix in Voyager. 

For other scenarios, a user can repeat Steps 1 to 3 above. 

4.2.2 Run with Master Network 

If a user needs to edit the model network extensively for both 2019 and 2040 network files, using the 
master network will provide consistent editing for both years and will save time by editing a network file 
once. Here are steps to run a 2019 model: 

1) Copy the “_MasterNet” folder to any folder on your computer. 

2) Copy the 2019 folder to the folder where the “_MasterNet” folder is copied to. 

3) Edit any input files if necessary, including the master network file. All other input files are stored 
in the “inputs” folder. 

4) Run the SPRTA Pre-step script (SPRTA_Pre-Step_CreateNet_2019_vXX.s) with Voyager 6.4.4 by 
double-clicking it. This script will generate a 2019 network file from the master network file. The 
SPRTA Model does not require a prefix in Voyager. 

5) Once the Pre-step run is complete, run the SPRTA regular model script 
(SPRTA_Script_2019_vXX.s). 

For other scenarios, a user can repeat Steps 2 to 5 above. 
  

http://www.bentley.com/
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5.0 DESCRIPTION OF MODEL FIELDS 

The starting point of developing the SPRTA Model network was the SACSIM19 network files. Thus, the 
SPRTA Model network inherited the SACSIM19 coding code.  

Exhibit 1: Master Network Fields 

Network Field Description 

DISTANCE Auto-generated link distance (miles). 

FLGxx Flag indicating whether links should be turned-on or off for each model year. 

LANESxx Number of through-lanes in the link's direction 

SPEEDxx Free-flow speed, or average travel speed with no congestion. 

CAPCLASSxx Capacity class code (see Capacity Class Lookup Table). 

HOVLINKxx 

0 = All trips permitted 
1 = Walk and bicycle trip only 
2 = HOV-only facility in freeway 
3 = HOV-only bypass lane at metered on-ramp 

PREVOLAMxx Non-Placer County traffic (AM 1-hour) for each model year from SACSIM19. 

PREVOLPMxx Non-Placer County traffic (PM 1-hour) for each model year from SACSIM19. 

PREVOLOPxx Non-Placer County traffic (Off peak period) for each model year from SACSIM19. 

FLG_PRELOAD Flag indicating links with preload. 

BIKExx Bike link facility information inherited from SACSIM19. Not used in SPRTA Model. 

VAL_ID Traffic counts location ID. 

AVGTRVDST Average travel distance of Placer County traffic from each gateway per Replica. 

Notes: xx indicates a two-digit model year 

 

Exhibit 2: Scenario Network Fields 

Network Field Description 

DISTANCE Auto-generated link distance (miles). 

VAL_ID Traffic counts location ID. 

AVGTRVDST Average travel distance of Placer County traffic from each gateway per Replica. 

LANES Number of through-lanes in the link's direction 

SPEED Free-flow speed, or average travel speed with no congestion. 

CAPCLASS Capacity class code (see Capacity Class Lookup Table). 

HOVLINK 

0 = All trips permitted 
1 = Walk and bicycle trip only 
2 = HOV-only facility in freeway 
3 = HOV-only bypass lane at metered on-ramp 

PREVOLAM Non-Placer County traffic (AM 1-hour) for each model year from SACSIM19. 

PREVOLPM Non-Placer County traffic (PM 1-hour) for each model year from SACSIM19. 

PREVOLOP Non-Placer County traffic (Off peak period) for each model year from SACSIM19. 
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Exhibit 3: Capacity Class Lookup Table in SACSIM19 
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Tabular input files can be mostly edited by text editors or Excel. In the case of DBF, simple edits can be 
done in Cube. As MS-Excel no longer supports saving data as DBF, MS-Access or a third-party program 
may need to be used for extensive edits. 

Exhibit 4: Land Use Fields 

Label in Model Land Use Description Unit 

TAZ TAZ numbers   

ATYPE Area Type. All fee districts are coded as area type 1.   

ATYPE_STR Fee District description   

IX_A Station Weights for IX attraction   

XI_P Station Weights for XI production   

TERMINAL_O Origin Terminal Time   

TERMINAL_D Destination Terminal Time   

SFDU Single Family Dwelling DU 

MFDU Apartment DU 

ARDU Senior Adult Housing-Detached DU 

RET Shopping Center 1,000 SF 

MALL Mall 1,000 SF 

OFF Office 1,000 SF 

IND Industrial Park 1,000 SF 

HTI Light Industrial 1,000 SF 

CC Community Commercial 1,000 SF 

CHURCH Church 1,000 SF 

LODGE Club 1,000 SF 

MED Medical/Dental Office 1,000 SF 

HOSP Hospital 1,000 SF 

CONV Convalescent Hospital 1,000 SF 

HOTEL Hotel Room 

PQPL Fire Station, Museum, Water Treatment 1,000 SF 

PQPH DMV, Post Office, Library, Police, Government Building 1,000 SF 

SCHOOL K-12 School student 

GOLF Golf Course Hole 

PARK City Park Acre 

CEM Cemetery Acre 

FAIR Fairgrounds Acre 

UNIV University/College student 

Special Special Generator Trip 

S1 Spare 1 none 

 
 


